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1.0 Credits

Special thanks to the Sentient Mice:  Apprentice, Buc, Eric, Gordo, Jill, JM, 
Krgon, Lizard, MadProg,*mage*, Maverick, Robert, Robin, and Starbuck; who play-
tested and commented as Teltnuag ][a was developed and redeveloped.

2.0 Objective

Your mission should you choose to accept it is  to retrieve the Sword and Armor 
of Teltnuag, four (4) pieces in total.  Rumors say that each of the last rooms has one of 
the items you are questing for.  Once you have all the pieces, you must fight and defeat 
the Dragon Queen.  When the  Dragon Queen dies, the magical aurora surrounding 
her disipates and the magical Ring of Teltnuag will appear.  The Ring of Teltnuag will 
teleport you to the throne.  

Upon successful completion of the quest, you will be crowned king;  should you 
fail, your name will join the long list of those that have tried and failed. 

3.0 About Teltnuag ][a

This is the first version of what was intended to be multi-person AppleTalked 
game.  Unlike other dungeon-exploring games where the rooms are relatively the same 
and become boring after a few visits, you can design your own, more challenging 
rooms (see Section 8.0).  
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Because a licensing agreement is needed for the Appletalk drivers, I probably 
will never be able to release a multi-person version of the game.   I have heard that 
purchasing such an agreement is not very cost effective.  However, I may at a later 
time design a room-creation program or extension to the existing program to make that 
aspect of the game easier.

This program is SHAREWARESHAREWARE.  You may freely pass it on to your friends and I 
encourage you to do so, provided you pass it as one complete package: the program, 
the original seven (7) rooms, the original seven (7) room text files, the Room.Master, 
and this  help  notice.   If  you  like  what  you  see register  your  copy  and send your 
appreciation; if you don't then I ask you to trash the files or pass them on to a friend. 

When passing the program onto your friends, pass it as you got it, all files are to 
be unaltered and all copyright notices must be intact.   I retain all rights to the Teltnuag 
package. 

You are free to add your own rooms and pass them along to your friends.    
However, you may not receive any monetary compensation for any rooms that you 
personally write nor may you sell Teltnuag ][a and/or any other part of the package in 
whole or in part.

Shareware and Public Domain distributers may include the Teltnuag ][a package 
in their software libraries and may charge a reasonable copying fee.  Users that obtain 
their version of Teltnuag ][a from these distribtuters, remember that you are only paying 
for the diskette and the copying time and not the program(s) that are on the disk.

Send  your  appreciation  ($5)  to  the  address  below.   Any  comments  or  bug 
reports can also be sent by snail mail to:

Kevin S. Wiechmann 
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561 Blueberry Place
Franklin Lakes, New Jersey 07417

or by e-mail to:

WIECHMANN@RUTGERS.RUTGERS.EDU

You should  have a copy of Macintalk because the program is more interesting 
with it, however I cannot and have not included Macintalk with this distribution because 
it is copyrighted.  Macintalk has already been distributed along with number of other 
freely available programs, so you should be able to find copy of it.  Any distribution of 
the Macintalk driver with the package is the sole responsiblity of the passer and is not 
the responsibility of the original distributer and creator, me.

I express no warranties either implied or written.

4.0 Getting Started

Make a system disk either 400K or 800K but HFS.   Teltnuag is not MFS 
compatible.  Be certain to have some free space left; you'll need 10K.   Place Macintalk 
in the System Folder.  Place the Teltnuag ][a and Room.D icons in the same folder.   

You should have at least the following files.  You might have more files if more 
rooms have been created:  
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Double-click on the Teltnuag icon and away you go.

The program will play an introduction and display the starting game scenario (The 
mouse button will bypass these).   

Now, the fun begins.  Examine the Help option under the Options menu to learn 
the controls.  Choose your class using the Class menu.  Now under the  File menu 
choose Let the Game Begin...
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5.0 Character Classes

Barbarians are rough and tough fighters prefering to bash monsters over the 
head with their swords.  They love the heat and smell of melee combat.   On the other 
hand, they detest anything magical (wands, scrolls, and potions) and are also unable 
to use bows.

Clerics are able fighters and can turn the undead to ash.  Clerics have an 
endless supply of turning spells which only work on skeletons, evil wizards, and 
hackable walls.  Clerics are able to purify their food and thus, never have to worry 
about rotten food.

Knights are also able fighters and can use wands due to their higher learning 
and training.  Knights aren't as strong as Barbarians because they also strive to 
exercise their brain.

Rangers love to use their magical bows, but are also capable of some hack-
and-slash.  Rangers never use wands due their strong preference for bows and their 
woodzy education.   A Ranger's quiver is never empty.
 

Wizards are the physically the weakest class, but have the strongest potential. 
Wizards are totally awesome with wands.  Unfortunately, although wizards can stretch 
out wand charges better than any other class, wands will and do run out.  The power 
of wizards become more apparent the further one ventures into the rooms. 
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6.0 Encounters and Objects

Blindness trap

Creature generator

Doors

Dragon children

Dragon Queen

Evil wizard (undead)

Food

GRUnt (Ground and Recon Unit)

Hackable wall

Jewel

Key
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Lantern

Poison trap

Punster

Portal to the next room

Scroll of Superzap

Skeleton (undead)

Teleport trap

Teltnuag, Armor of

Teltnuag, Helmet of

Teltnuag, Ring of 

Teltnuag, Shield of

Teltnuag, Sword of

Torch
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Treasure chest

Wall

Wand

Water trap
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7.0 Instructions and Hints

• If you are using System 3.2 and you eject the diskette while saving a room or 
progress, you may have to click somewhere inside the dialog box on something or 
do a <control> <shift> <one> to get the diskette to be noticed.   This is due to a 
bug in System 3.2 itself.  I have tried to program around and prevent it as much as 
possible but, nevertheless it may still appear.

•  Teltnuag will not load properly under Switcher.  However, it will not bomb Switcher.

• Teltnuag and the room files need to be installed at the top most level of disk, i.e. 
put the files at the "root" level.  Teltnuag will not work from inside a folder.

•  To begin the game (either a new or an old game), you must choose the  Begin 
Game option (Control B) under the File Menu.

• There are forty rooms.  You can not enter the fortieth room until you have collect 
the four items you began your quest for:  armor, helmet, shield, and sword.

• Firing missile weapons (Rangers), zapping wands (Knights and Wizards), or 
turning the undead (Clerics) is best done by shooting several squares past the 
intended victim.  Shooting can only be done in the in the following directions: 
North, NorthEast, East, SouthEast, South, SouthWest, West, and NorthWest.  You 
may shoot/zap between diagonal-wall sections.

•  Players are limited to movement in the following directions:  North (E -key), South 
(D-Key), East (F-Key), and West (S-Key).

• Potions will heal most classes.  Potions will also neutralize poisons.

• Generated monsters are harder to kill than those at already present on the room.

• Not all walls are not impenetrable.
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• And of course, the monsters become harder the further you adventure.
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8.0 Creating Your Own Rooms

Warning —  Creating your own rooms is fairly easy except that you must be  
careful.  Rooms that you generate may cause the program to hang or do unexpected  
things.  I have tried to bomb-proof this part of the program as much as possible, but  
there are still holes.  The room-creation program or extension, if and when written, will  
eliminate this problem.

To create and install your own levels, you will need some type of text editor or 
wordprocessor in addition to the Teltnuag package.    Programs such as MacWrite or 
MicroEmacs will do fine.

If Teltnuag ][a is on an 800K system disk, you should have enough disk space to 
prevent a lot of disk swapping.  If you are using a 400K disk, there may not be enough 
room to have both the Teltnuag package and the editor on the same disk and you may 
have use two disks.

Double-click the editor.

Open the file Room.Master.  If you are using MacWrite or possibly some other 
word processor, a dialog box will probably come up asking how to interpret carriage 
returns.  Answer New Paragraph  by pressing the appropriate button.

If you are able to change the font in which the document is displayed, use 
Monaco 9 or some other small font in which all the characters are the same width.  
This really isn't necessary but will make room creation simipler because all the 
columns will line up. 

You will notice that it is appears to be a table of numbers made up mostly of 
98's and 00's.  The first line and second lines are slightly different.  The first line 
enumerates from 01 to 29 inclusive; the second line is merely blank.  Both of these 
lines are for your convenience in creating levels but must be in the file when 
converted.

Now the actual creation begins.  Using Table 1,  replace  the 00's one for one 
with the code of the object that you want to appear.  If you should not  place a code in 
the first and last rows or columns of 98's which form a border, the code will be 
replaced with the wall code when read by Teltnuag.
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Table 1
Code Object
00 Empty squares
99 Blackness
98 Walls
97 Portal to the next room
96 Vertical doors
95 Generators (generate different monsters depending

upon the room)
94 Keys
93 Food
92 Treasure
91 Horizontal doors
90 Potions
89 Wands
88 Gems
87 Poison traps (are set only in rooms 20 => 40)
86 Blindness traps (are set only in rooms 35 => 40)
85 Superzap scrolls
84 Teleport traps (are set only in rooms 8 => 40)
83 Hackable walls
82 Lanterns
81 Torches
80 Water traps (are set only in rooms 3 => 40)
20 Dragon children
19 Evil wizards
18 Skeletons
17 Grunts
16 Punster

A few hints on creating rooms:

° Do look at the level.d.txt files before creating your own levels. They are examples 
of what can be done.

° Do place a wall piece as cornerstone where horizontal and vertical doors meet.
° Do fill any part of a room that is "unescapable" with blackness (code 99) or 

permanent wall (code 98).
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° Be generous with keys. 
° Be conservative with the amount of food in a room.
° Be conservative with the amount of lanterns and torches in a room.
° Be conservative with wands, Scrolls of Superzap, and Potions.
° Be conservative with the amount monsters placed in any room.  The more 

monsters in a room, the slower the game.

Once you have finished creating a room, save the file to disk. For those that are 
creating levels with a word processor, save the file in TEXT format with end-of-line 
signifying carriage return.  Those using a regular editor shouldn't have to worry about 
this.  

To let Teltnuag know that there are more than 6 rooms, create another TEXT file 
containing just the number of rooms you want to use.  Teltnuag will create the Max 
Room file if there isn't one already.  Again save the file as TEXT with the filename 
Max Room.  

You are finished with the editor unless of course you decide to change the level 
at a later time.

The room has been designed and created as well as "installed,"  but it still 
needs to be converted.  Double-click Teltnuag ][a.  Convert the file into the room-file 
format using the Make Room option under the Options menu.

And you are done.  Have fun challenging yourself!


